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Abstract: The increasing trend of technology has changed the 

users’ expectation towards software product. In which, the 

successful of software product is mainly reliant on their creative 

and innovative features.  Thus, creative ideation becomes a focal 

issue in software development, particularly in requirements 

engineering process for generating creative and innovative 

software requirements. Subsequently, software developers realize 

the benefits of crowd where it involves a wide diversity of 

stakeholders to express their perceptions or ideas about the 

software product. The various ideas from the crowd are useful as 

a source of software requirements, specifically for creative 

requirements.  However, to filter and analyze the large amount 

and heterogeneous ideas from the crowd is a great challenge.  

Considering the benefits of morphological approach, thus, in this 

paper we demonstrate the application of morphological matrix to 

discover creative requirements from the crowd in a case study. 

Keywords: requirements elicitation, requirements engineering, 

morphological matrix 

INTRODUCTION 

Besides of its benefits, the increasing trends of 

technologies inevitably put pressure to software product to 

compete in the market. The objectives for the software 

product are not only has to be usable and bring values to the 

users.  It should also provide creative features that beyond 

the users’ expectations. Thus, this is a challenge in software 

development for identifying requirements for software 

product.  It is crucial as the success or failure of the software 

product is depending on its requirements. Thus, various 

techniques are used for eliciting requirements and known 

techniques are like brainstorming, workshops, survey, and 

interview. While, other recent techniques have also 

emerged, for example, viewpoints approach, analogical 

reasoning, and walkthroughs among others that is based on 

the co-presence of the stakeholders. Some of these 

techniques are too costly and time-consuming when 

employed to a larger number of stakeholders.   

The current trend of requirements elicitation is by 

utilizing crowd as a source of requirements (e.g., Hassan et 

al, 2017b, Murukannaiah et al., 2016, Lim et al., 2010). 

Crowd is described as a heterogeneous group of 

stakeholders, large enough in size for group effects to occur 

when they interact  (Groen et al, 2015). Basically, it is a 

group of people that have common interest in a 

certain product, discuss about that product, and the 

discussion is likely to influence opinions and decision-

making. Crowd is a beneficial source for software 
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development that has been utilized at the requirements 

engineering as well as design phase.  Yet, in requirements 

engineering, the challenge is to analyze and discover 

requirements from the crowd that is known as large and 

heterogeneous.  

Another concern in requirements engineering is that 

requirements should be imagined and invented by 

stakeholders, rather than being simply “gathered” from them 

(Maiden, et al.,2010). The needs of creative requirements 

for improving software product have also been mentioned in 

the previous research (e.g., Hassan et. al, 2017b, Maiden & 

Horkoff, 2015, Karlsen et al., 2009).  Sternberg and Lubart 

(1995) defined creativity as “the ability to produce work that 

is both novel (i.e. original, unexpected) and appropriate (i.e. 

useful, adaptive to task constraints)”.  Creative requirements 

also mentioned as important to represent innovative features 

to support competitive advantage for software industries 

(Hassan et al., 2017b).  Creative requirements can be 

identified by integrating creativity technique at requirements 

engineering stage during idea generation or requirements 

brainstorming. Moreover, creativity techniques encourage 

the collaboration of stakeholders and requirements engineers 

in order to create creative ideas for the software product.   

A morphology approach to elicit requirements from 

crowd has been presented in our previous work (i.e., Hassan 

et al., 2017a).  Further, this paper presents the formation and 

usage of morphological matrix to explore creative software 

requirements from crowd. The following sections discuss on 

related work, continue with the proposed work, discussions 

and finally the conclusions. 

RELATED WORK 

This section discusses related issues and efforts to support 

the ideation process towards creative requirements for 

software product. 

Most researchers typically have seen the field of 

requirements engineering (RE) as a problem solving 

process. RE practitioners have acknowledged about the 

importance and the role of creative techniques applied with 

engineering principles for solving requirements problems 

(Maiden et al, 2010). Franco and Assar (2016) reported 

Creativity-Based Approach for Requirements Elicitation 

(CARE) have appeared as one promising trend and 

important subject among practitioners and researchers to 

tackle the requirements elicitation problem. 

Moreover, few researchers have developed software tools 

to support creative thinking during requirements engineering 

processes (e.g., Karlsen et al., 2009). However, these tools  
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should be integrated within requirements engineering 

process towards producing creative requirements 

specification (Nguyen & Shanks, 2009).  Thus, Nguyen and 

Shanks (2009) have developed a framework for 

understanding the role and potential of creativity in 

requirements engineering focusing on the product and 

process perspectives. Three characteristics are essential for a 

product perspective, which are novelty (i.e. new, original), 

value (i.e. helpful, useful), and “surprisingness” (i.e. 

unusual, unexpected). While, for process perspective, 

Nguyen and Shanks (2009) adopted the analysis from Boden 

(1991) and Shneiderman (2000).  Where, the creative 

process is as an internal process of exploration and 

transformation of conceptual spaces in the individual mind. 

The adoption of creativity techniques in RE helps to 

examine and incorporate the novelty and “surprisingness” in 

requirements, as well as discover future technology-enabled 

solutions to software product.  

It is mentioned that morphology analysis is one of the 

promising method in the creative ideation process (Pidd, 

1996; Kim et al., 2008). Moehrle (2010) define morphology 

analysis as a structured invention method by finding all 

possible alternatives for solving problems and Pidd (1996) 

described its ability to model complex problems in a non-

quantitative manner. The basic idea of morphology analysis 

is that the subject is broken down into several dimensions, 

through which the subject can be described as 

comprehensively and detailed as possible (Kim et al., 2008).  

Morphology has been applied to many areas such as 

scenario analysis (Kosow and Gaßner, 2008), new idea 

development (Kim et al., 2008; Geum & Park, 2016; Geum 

et al., 2016), technological opportunity discovery (Yoon et 

al., 2014), and business model generation (Im and Cho, 

2013; Seidenstricker and Linder, 2014). Yoon and Park 

(2005)’s work deals with how to build shapes in the 

morphological matrix. The shape of morphological matrix is 

developed based on the text mining of patent database. 

Where, the morphology analysis extracts the specific 

morphology of the software-to-be.  While, Yoon et al. 

(2014) has used text mining techniques to develop shapes of 

the morphological matrix. Work by Yoon et. al (2014) and 

Guzman and Malej (2014) has shown the potential of the 

approaches in improving the requirements elicitation 

process in term of producing creative requirements. The 

potential of morphology approach in requirements 

elicitation process have been mentioned in the previous 

work by Hassan, S., et.al, (2017a). 

Creative requirements may arise from stakeholders. The 

larger number of stakeholders involved, the higher number 

of creative ideas can be derived.  Thus, large and 

heterogeneous stakeholders, like crowd, may bring a lot of 

creative ideas for software product. Crowdsourced Software 

Engineering has also rapidly gained increasing interest in 

both industrial and academic community’s touches 

numerous dissimilar aspects of software engineering. Crowd 

could be the potential users of the software-to-be where it is 

designed to meet their requirements. There are a number of 

studies (e.g., Hosseini et al., 2013; Wang et al., 2014; 

Murukannaiah et al., 2016; Hassan, S et al., 2017) which 

tries to utilize the power of crowd to improve requirements 

engineering process.  Therefore, crowd can be used as a 

source of requirements in which about one third of the 

product’s reviews from crowd contain information related to 

requirements (Pagano & Maalej, 2013; Carreño & 

Winbladh, 2013). Consequently, product reviews from 

crowd can be used as a source for the dataset to gather the 

ideas for the certain software product. Where, the data can 

be elicited from text (e.g., reviews, reports, transcripts (of 

chat discussions or phone calls), emails, or any documents) 

or from product’s  log data which are collected 

automatically (e.g., mouse clicks, duration counts, system 

log outputs, and sensor data). 

CREATIVE REQUIREMENTS FROM 

MORPHOLOGICAL MATRIX 

This section describes in details the steps carried out to 

explore creative requirements based on the morphological 

matrix. The input is derived from the reviews and feedback 

gets from the crowd. To illustrate the process, users’ reviews 

of Dropbox application obtained from 

http:///www.g2crowd.com were used as sample data.  The 

reviews were scrapped, collected, and extracted using online 

web scrapping tool (available at https://www.import.io/) and 

about 8,926 rows (record) were extracted.  

 

 
Figure 1:  Morphological Matrix for creative 

requirements 

 

This work utilized text mining techniques to extract 

keywords from the records and to select the most 

appropriate values based on the keyword frequency for 

forming the morphological matrix. Work by Sarkar (2016) is 

referred for the implementation. For forming the 

morphological matrix it involves; identifying major 

dimensions, and identifying possible attributes each 

dimensions might have.  Then, exploring random 

combinations of attributes for creative requirements 

identification (i.e., by selecting one attribute from each 

parameter for each combination).  Figure 1 illustrates the 

steps and the following paragraphs explain each of the steps. 

Text Pre-Processing.  For this step, common natural 

language processing (NLP) techniques such as stop word 

removal, special character and symbol removal were used.  

In addition, techniques for identifying and extracting the 

noun, verbs, and adjectives in the text-based comments were 

also applied.   
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Key-phrase Extraction – The Fine-grained Features 

Extraction. Key-phrase extraction is used for extracting 

important information from unstructured text documents. 

Key-phrase extraction can extract the important key and 

relevant terms or phrases from unstructured text. 

Collocation technique is used where the collocations are 

grouped based on pairs of words that are synonyms. 

WordNet (Fellbaum, 1998) is used as a synonym dictionary. 

When grouping features together, the word collection with 

the highest frequency is considered to be the name of the 

feature. Figure 2 depicted some keywords/phrases extracted 

using collocation technique. 

 

 
Figure 2:  Sample of the extracted key-phrases using 

collocation technique 

 

The key-phrase extraction technique is able to produce 

varieties of key-phrases (i.e., possible features for the 

software). Besides, the features extracted consist of 

combination of two words or key phrases which is 

meaningful to the requirements engineer.  However, there 

are also features generated that are insignificant to the 

software development or irrelevant to the requirements 

context. So, these features need to be filtered out to ensure 

only the relevant features are gathered before implementing 

topic modeling techniques. 

Topic Modeling – The High-level Features.  Topic 

modeling involves extracting features from document terms.  

It has been designed specifically for the purpose of 

extracting various distinguishing concepts or topics from 

various types of documents, where each document talks 

about one or more concepts.  There are various algorithms 

for topic modelling; among the popular algorithms are 

Latent Semantic Indexing (LSI), Latent Dirichlet Allocation 

(LDA), and Non-Negative Matrix Factorization (NMF).   

At this stage, all the extracted key-phrases are groups 

based on terms that are distinguishable from each other, and 

these group of words form topics or concepts. These 

concepts can be used to interpret the main themes and also 

make semantic connections among words that co-occur 

together frequently in text data.  In this approach, LDA is 

used to groups the fine-grained features in order to produce 

topic or high-level features.  Figure 3 shows some of the 

results. 

 

 
Figure 3: Sample of topics 

 

However, human intervention is still needed for this 

activity.  As for examples, to identify the title for each topic, 

and remove repeating features in the different topics. The 

repeating features need to be removed to avoid conflict 

when building morphological matrix. 

Forming   Morphological Matrix.  The morphological 

matrix is built by using collocations and LDA.  The 

morphological matrix (as depicted in Figure 4) filled with 

high-level features (HL) as dimensions or topics, and fine-

grained features (FG) as values or attributes. 

Results & Discussions:   Creative idea is explored based 

on the relation analysis between parameters and options in 

morphological matrix.  Appropriate combinations are 

identified and selected as potential creative requirements. As 

for this purpose, a group of stakeholders may involve in 

assembling creative requirements for the software-to-be.   

 

 
Figure 4:  The Morphological Matrix 

 

 

 

Example: Combination 1 
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Various Device → Allow Easily → Small Amount → 

Multiple Location → Cloud Access →Phone Laptop →Use 

Personal →Invite People →Dropbox Offer →Business 

Need →Collaboration File →Email Attachment →Photo 

Take 

Example: Combination 2 

Pay Extras → Cloud File → File Host → Share Access 

→ Across Different → Client Share → Space Dropbox → 

User Access→ Store Photo→ Get Space →Document 

Team→ File Image →Drag Drop 

Requirements can be generated from the combinations.  

For examples, developers can build the application for 

sharing file that have these features; Allow easily for various 

devices, files stored in small amount and multiple location 

with cloud access functionality. Using by phone and laptop, 

user can use for personal and also can invite other people 

and more function offers for business need like file 

collaboration, email attachment and photo take. The 

creative requirements can be added-on to the total 

requirements for the software-to-be. 

Human intervention and decision making are still needed 

to further analyze each of the requirements that were 

developed in terms of its feasibility and applicability.  

DISCUSSIONS 

Generally morphological matrix can be built for the large 

text-based data from crowd using text mining techniques. 

The key phrase extraction technique is able to produce 

varieties of potential features for the software product. 

Through combination of these features, a large number of 

creative requirements can be explored.   However, some 

features extracted may insignificant or irrelevant. Therefore, 

these features need to be filtered out to ensure only the 

relevant features are gathered before implementing topic 

modeling technique. Furthermore, there is lack of guideline 

for generating number of features using key phrase 

extraction techniques, this flexibility give us a choice on 

how many features that needs to be extracted from the 

dataset. Number of topics to be generated and features to be 

extracted for each topic also can be decided.  

Besides that, another issue is the possibility to forego 

important or creative features if they are neglected due to 

the frequency of the features are low. This can be improved 

by adopting other techniques to allow for the identification 

of non-common features through patterns in addition to the 

term frequency. It is also suggested to collect ideas from 

specific groups of users or stakeholders that are interested 

on that particular software instead of wider crowd. 

Type of data collected from crowd is another concern, in 

which, user’s reviews are diverse.  Thus, it need to go 

through a classification process to determine whether it is 

bug reports, feature requests, user experiences, ratings or 

simple praise or dispraise.  And, the best way to do it is by 

building an automatic classifier of user reviews. 

Furthermore, sometimes the ideas are expressed in negative 

statement such as “We don't like multi user access the file”. 

Although, these negative statement can be filtered out when 

evaluating the ideas manually, but it would be effective if 

the process is done automatically.  

CONCLUSIONS 

Crowd-based requirements elicitation can extend the 

requirements elicitation by covering the total pool of 

stakeholders to a much higher degree, which will contribute 

to a better software product development. Other benefits 

including the diversity of generated ideas from crowd which 

typically differ from those generated with common 

requirements elicitation techniques. While, morphological 

matrix creative-based technique helps requirements engineer 

or developers to stimulate creativity. However, the proposed 

approach involves certain steps that still require human 

intervention. Thus, in future, automated tools to assist the 

process (for example, to automatically generate potential 

requirements from morphological matrix) which overcome 

the technical limitations and reduces the participation of 

human in the process should be developed. 
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